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Back by popular demand! Learn how to maximize productivity between 

designing in Revit software and rendering in 3ds Max software with NVIDIA’s 

Iray rendering engine. Discover all the settings and tricks you can use to 

properly set up a Revit model to make the transition into 3ds Max software as 

effective as possible. Once in 3ds Max software, all the work done in Revit 

software will transfer over, enabling more time for rendering and less time spent 

worrying about the design. The simplicity, accuracy, and speed of Iray will help 

the user create believable-looking renderings in the same way that a 

photographer would photograph a physical space. In the end, users will gain the 

knowledge of how to set up a seamless pipeline between Revit software and 

3ds Max software in order to help streamline the rendering process across any 

scale of a project. This session features 3ds Max and Revit Architecture.

Class summary
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At the end of this class, you will be able to:

�Effectively set up models in Revit for transfer to 3ds Max.

�Set up a direct link between Revit and 3ds Max.

�Manage lighting, cameras, and materials inside of 3ds Max.

�Render “Photo-Realistic” renderings with NVIDIA Iray.

Key learning objectives
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Chapter 1: The Digital “Digital” Photographer
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Playing Photographer

Images provided by NVIDIA
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CG Photo

Images provided by NVIDIA



© 2016 Autodesk© 2016 Autodesk

� Photo-Real 3D Render with a strong parallel to Photography.
� Built for Designers

� It just works!

� Progressive Rendering (Develops like a Polaroid)
� Physically based 
� Unbiased
� Interactive
� Floating Point (32-bit)
� GPU rendering is extremely dependent on RAM. 

� If you cannot load the entire scene on to the card, it will not 

render. Make sure you get the biggest card you can!

� You are only as good as the weakest card in your system!

NVIDIA Iray Overview
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� GTX 1070 ($)

� Entry Level

� GTX 1080 ($$)

� Best Bang for the 

Buck

� Titan X – Maxwell ($$)

� Super Fast

� Titan X - Pascal ($$$)

� Stupid Fast

� P5000 ($$$)

� Best Quadro for 

Price/Speed

� P6000 ($$$$$)

� Top Card

GPU Recommendations 
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� GTX
� Built for gaming

� Run SUPER HOT

� HIGH Power Consumption 

� Decent Viewport 

Performance

� Cheaper than Quadro

GTX Vs Quadro

� Quadro
� Built for CAD Applications

� More Energy Efficient

� Excels Viewport 

Performance

� More dependable than 

GTX

� Lots of RAM

� P6000 @ 24GB

� NVLink
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� It is recommended to have at least 2 GPUs for 
interactive rendering.

� Interactivity will need one GPU set for Windows only.

� Do NOT put GPUs in SLI Mode for rendering.

� Optimal Configuration:

� GPU 0 – Windows (Titan X, P4000, P5000, P6000)

� GPU 1 – Rendering (Titan X, P5000, P6000)

� GPU 2 – Rendering (Titan X, P5000, P6000)

GPU Configurations
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Chapter 2: Revit Setup
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� View Classifications:

� Visualization – Scene (Simple Workflow)

� This view is one export, and is best for speed. It can be ideal for those 

who want to do as little work in 3ds Max as possible.

� Visualization – Export (Advanced Workflow) (Recommended)

� A little more complex, but offers the most flexibility with the model. Ideal 

for those who want to work more in 3ds Max, but those who want to 

work in Revit more can still benefit from this workflow.

� Hide objects not seen for rendering for optimization:

� Views will only export what is visible.

� Not everything will be needed. This will be up to the user and what is being 

render.

� Reducing information that is not needed, will help optimize RAM and file 

size.

View Setup
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� Watch for the “Phase Filter” in the View Properties under the 
Phasing section.

� Exporting a 3D-View with the “Phase Filter” enabled will result in 

all the objects that are included in the filter to have a material 

override applied to them. This means when using this workflow, 

these objects will all be combined in to one massive object.

� It is recommended to export the phased options in their own FBX 

files if they are required for rendering. This will give full control 

over their materials as well.

� Phases will need to align with the view you are looking to render. 

If geometry overlaps on top of each other, this will cause rendering 

issues and will not look correct. The pieces need to fit like a 

puzzle, which is how the rest of this workflow works.

View Setup
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� View Setup:

� Place a Camera for the view you want to render.

� Make sure lights are visible and turned on.

� Make sure elements that are not needed are hidden.

� Use a section box or disable categories in Visibility Graphics.

� Make a duplicate of the same view, and hide everything but Railings 

and any additional curved objects.

� Do this only if the scene has extensive amounts of railings and 

curved objects.

� Must export the 

� This view is one export, and is best for speed. It can be ideal for 

those who want to do as little work in 3ds Max as possible.

Visualization – Scene (Simple Workflow)
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� View Setup:

� Multiple Views for Export

� RVT/FBX: Base Building, Interiors, Core, etc

� RVT/FBX: Curtain Wall and Mullions (Must Filter Out Walls)

� RVT/FBX: Furniture

� RVT/FBX: RCP + Lighting Fixtures

� DWG: Railings and other curved objects

� RVT/FBX: Site and Entourage

� Make sure unneeded elements are hidden in all views.

� Make sure elements are not visible in more than one view.

� Use a section box, or disable categories in Visibility Graphics.

Visualization Export (Advanced Workflow):
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� File Organization:

� Able to “archive” exported versions of your project.

� Able to organize large projects inside of 3ds Max easier.

� Protect against File Corruption

� By splitting exports you can reduce losing all your work when 3ds Max 

decides it doesn’t want to work on a Saturday.

� Multiple people working on the project at once.

� This can be done by loading the multiple exports into their own 3ds Max 

files, and Xref them into a “Master” 3ds Max file. This is explained later 

in the document.

� Best way for 3ds Max to handle large scale projects.

� 3ds Max can handle millions of polygons, just not millions of objects. 

The multiple exports help consolidate the model.

Why do the Advanced Workflow over Simple?
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� Set a View for each desired camera to bring into 3ds 
Max. 

� If using the Simple Workflow, only one view should have 

everything visible that is needed to be rendered in 3ds 

Max.

� All Camera views should have everything hidden.

� Do this by disabling everything in Visibility Graphics (VG).

� Each View is then exported via FBX.

� Create a naming convention for the view, and name the 

FBX the same.

Cameras (2015 and below + FBX Workflow)



© 2016 Autodesk© 2016 Autodesk



© 2016 Autodesk© 2016 Autodesk

� Linking any view into Revit will bring in every camera 
placed in the Revit file regardless of the view linked.

� It is best to create two presets, one with cameras 
enabled, and the second with cameras disabled.

� More on this in a few slides!

Cameras (Revit Link Workflow 2016+)
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� Name your materials!

� Consider using a naming convention for all your materials for optimal organization. Try following 

the drawing codes that the project specifies for materials. This helps greatly when coordinating 

with other designers on the project. If the code does not work, try something along the lines of: 

[MATERIAL TYPE]-[SUB-TYPE]-[DESCRIPTION]

� Just use something that works best for the project, and then stick with it. It can be very painful to 

change this later.

� Make sure all objects have materials.

� Review imported families from 3rd parties. They can sometimes not have any materials applied, 

or their own names.

� Objects without materials can cause rendering artifacts in the render process.

� All objects without materials will receive a material called Generic inside of 3ds Max.

� Set material properties in Revit.

� Use materials from the Autodesk Physical Asset library as a good place to start!

� Only needed if you want to edit materials in Revit instead of doing it inside of 3ds Max.

� Add more detail to materials by adding reflection and bump maps.

Materials
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� System Families

� Make sure floors, walls, ceilings, are all properly aligned. This will help close any gaps in the 

model that could introduce light leaks.

� This includes modeling areas around dropped ceilings and soffits.

� Be careful of overlapping surfaces. Geometry that is right on top of each other will creating 

rendering artifacts. Hiding one of the elements from view will eliminate this.

� This issue is seen a lot with structure slabs and floors, and in some situations certain 

wall elements.

� Make sure Families are optimized for Revit

� Poorly created families can have bad performance in Revit, and crash 3ds Max during Iray

rendering.

� Keep track of families with lots of curves

� Curved objects need to be exported via DWG.

� This only applies to curved objects that are created natively in Revit.

� Name Families for organization

� Use a naming convention that works for you.

� Add and Remove any meta-data in the families that you need.

Families
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Poorly Created Family Example
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� Add Lighting Objects to Lighting Fixture Families.

� Make sure not to place Lighting Objects inside of the family. Place them 

just slightly below the light.

� Add IES files to the Lighting Objects.

� This will mimic real-world fixtures, and will add a higher level of realism 

to your renderings.

� Make sure to set a proper lumens value to the light, if no IES file is 

available.

� Use a naming convention to organize lights.

� Add/Remove any meta-data that you might need.

Lighting Fixtures
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Chapter 3: Export and Link to 3ds Max
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� All changes done in Revit update to 3ds Max

� Super-fast and easy! Just save your files and hit “reload”!

� Editing geometry in 3ds Max is not advised with linked objects

� This can cause issues when updating the link

� Materials can be edited in either Revit or 3ds Max

� Note: You can only edit materials in either Revit or 3ds Max

� 3ds Max has more advanced Materials for better realistic 

looking results.

� People working in Revit and in 3ds Max can work together 
almost seamlessly.

� Communication between team members is the key!

File Link Benefits
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Export File Formats
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� You need to use a filter to only see Curtain Walls and Mullions in their own 

view.

� This is applied in the Visibility Graphics Settings under “Filter”.

� You do not need to do this in Revit 2013 and below.

Filter Curtain Wall and Mullions Only
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� Export DWG as ACIS.

� This is located in the 

export DWG settings 

under the “Solids” tab.

Exporting Railings and Curved Objects
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Exporting Railings and Curved Objects
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DWG ACIS Export of Curved Objects
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� 3ds Max system units need to be set to Feet. 

� FBX exported from Revit only comes in properly when you use Feet.

� You will experience issues with modifiers and UVW if you do not.

� DWG Files export by default in Inches. 

� This can be changed in the export settings in Revit. If you forget, all you 

need to do is rescale the DWG on import.

� If directly importing FBX, use the Entertainment Preset when importing 
for more import options.

System Units and Import Tips (3ds Max 2015)



© 2016 Autodesk© 2016 Autodesk

� Work-Around #1: Change System Units

� Set System Units in 3ds Max to Centimeters.

� Not Ideal if different units are required for the project.

� Work-Around #2: The FBX Import Trick

1. Set 3ds Max to the System Units required for the project

2. Go to File > Import

3. Select the FBX File

4. In the Import Options go to Advanced Options > Units

1. If you do not see Advanced Options dropdown, switch the preset at the top to 

Autodesk Media & Entertainment

5. Uncheck “Automatic”

6. Pick the Units required for your project from the dropdown list.

7. Import the FBX.

8. Delete everything Imported

9. DO NOT CLOSE OR RESTART MAX

10.Go to File > Import > Link FBX

11.Link FBX File

System Units and Import Tips (3ds Max 2016 
FBX Workflow)
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� 3ds Max system units need to be set to the same units as Revit. 

� FBX exported from Revit will need to match for project continuity!

� DWG Files export by default in Inches. 

� This can be changed in the export settings in Revit. If you forget, all you 

need to do is rescale the DWG on import.

� If directly importing FBX, use the Entertainment Preset when importing 
for more import options.

System Units and Import Tips (3ds Max 2017 
SP2+)

Everything is fixed in 3ds Max 2017 SP2!
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� Combine By Materials:

� Base Building / Interiors

� Curtain Wall and Mullions

� RCP

� Do Not Combine (Optional):

� Furniture

� Site and Entourage

� Railings and Curved Objects

� Lighting Fixtures

FBX/Revit Link Settings
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� Keep 3ds Max scene materials parameters on reload.

� This is recommended if adjustments to the material properties will 

happen inside of 3ds Max. If the name of the material stays the same, 

the material will not be overridden when reloading the file. If left 

uncheck, the material will be overridden and replaced with the latest 

version from Revit. 

� Converting materials to another format is ok, as long as the material 

name stays the same.

� Keep 3ds Max scene material assignments on reload.

� This is recommended if new materials will be created and applied inside 

of 3ds Max. Since a new material have been created, 3ds Max will not 

replace the newly created material with the latest version from Revit 

when this is enabled. This checkbox is highly recommended for DWG 

imports, as they do not bring in any materials to begin with.

Material Linking
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FBX/DWG Link Preset Settings

FB

X

DWG
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� Import your multiple FBX and DWG files into their own 3ds Max Files
� Xref all the files into one main “Master” file

� Less chance of losing all your work

� Easier to swap parts in and out

� Allows multiple people to work on the same project

� Multiple “Master” Files can be created for different scenarios

� “Testing” materials and lighting is a little more tedious

� Create a test file for faster testing, then apply to the main model

Xref into a “Master” file
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Chapter 4: 3ds Max Settings
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Make sure to install NVIDIA Iray and 
Mental Ray with 3ds Max 2017!
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� Make sure Gamma is 
enabled and set to 2.2.

� Use the following equation 
to convert RGB Values into 
linear values for 3ds Max 
and Iray.

� ((rgb/255)^2.2)

� 255*((rgb/255)^2.2)

Use this for sRGB

Gamma Settings
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� Compatible Shaders:

� Autodesk Materials

� Arch & Design

� Iray Shader

� MDL (3ds Max 2016+)

Materials
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� If you set your material 
properties in Revit, these 
will be good to go!

� Quick and Easy!

� Hundreds of presets to 
mimic a wide range of 
architectural materials!

Autodesk Materials
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� Extremely Powerful, 
Flexible, and 
Customizable!

� Lots of Presets!

� Special Functions!

� Curved/Beveled Edges

Arch & Design
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� Optimized for use in Iray
� Must download from NVIDIA 

directly. Not supported by 
Autodesk.

� Download Free at 

http://blog.irayrender.com

� You will also have to install 

this on all of your render 

nodes.

� Amazing quality and presets.
� Powerful and easy to use.
� Multiple “Coats” for complex, 

reflective, materials.

Iray Shader
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� Key Features of MDL

� Designed primarily for GPU Rendering with Iray 
as the main platform.

� Can define extremely complex materials 
through multiple parameters and additional 
layers and coatings.

� Parameters can be added for custom-built 
material libraries.

� This allows for a base material to be set, 

and additional customization of that 

material for specific instances.

� Is designed to be adopted by other render 
engines.

� MDL Libraries be easily packaged and 
distributed across any series of renderers that 
support MDL.

� This allows a single unified look for 

materials across all platforms! There is only 

a need for one single material library in a 

production environment. 

� Supports traditional rendering techniques that 
work well with conventional rendering 
pipelines.

MDLs
� Enable MDL inside of 3ds Max follow the steps at the 

Mental Ray Blog

� http://blog.mentalray.com/2015/05/08/using-mdl-

with-mental-ray-in-3ds-max-2016/

� Current Limitations inside of 3ds Max 2016

� Editing MDL materials can only be done on the 

parameter level inside of 3ds Max after loading 

external MDL code.

� Parameter connections to other MDLs or other 

Shaders are currently not supported.

� Measured Materials are not yet handled by 

Mental Ray 3.13.

� More technical information can be found here:

� http://www.nvidia-arc.com/products/Iray/mdl-
materials.html

� http://www.mdlhandbook.com/
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� Key Features: 

� Procedurally generate an infinite amount of 

Materials and Variations

� Render with Iray directly inside of Substance 

Designer for a 1:1 Material preview of what 

would appear inside of 3ds Max

� Export MDL files to use directly with Iray and Iray 

for 3ds Max

� First full node-based MDL Editor

Substance Designer 5.5

Created by Allegorithmic, and can be found at: www.allegorithmic.com
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See Handout on How to import Substance 
Designer MDLs into 3ds Max 2016 and 2017
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DV15677 – Procedural PBR Material Creation 
Using Substance Designer for Visualization

Thursday at 8:30AM

Room: Marcello 4404, Level 4
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� Use the Daylight System for Sunlight and Skylight

� Make sure to add mrSky into Environment Map slot

� Control Sun Location and Time via the Motion Tab

� Use Photometric Lights for optimal quality and performance

� Standard lights not fully supported

� Lights added in Revit will transfer in as Photometric Lights

� Use color temperature for a more realistic look

� Setting the light’s color to “White” will look boring

� Artificial lights should not go above 5000K in most cases

� Number of Lights does not affect performance

Lighting
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� Enable this under Environment.
� Use the EV scale for quick and easy settings.
� Use the Camera Settings for more advance control.

� Try to use real world exposure values for more realistic quality.

� Set Highlight and Shadow settings to 0.

� Better to crush these settings in post, and not the render.

� Make sure to set the White Balance to match your lighting.

mrPhotographic Exposure Control (3ds Max 2013-2015)
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� Physical Camera Features

� DSLR Camera Settings for each Physical Camera in the scene

� Film/Sensor settings that mimic real-world sensors

� Ability to change Shutter Speed to different types

� Recommended 1/seconds to mimic DSLR

� Enable Motion Blur for each Physical Camera in the scene

� Can use EV Scale or Specific ISO Value

� White Balance for each Physical Camera in the scene.

� Enable Depth Of Field which is controlled by Aperture, Film Width, and Focal Length

� Settings for Bokeh Effect

� Physical Camera Exposure Control enables global exposure with exposure for each individual 

camera in the scene.

� Under the Physical Camera Exposure Control, leave the setting “User Per Camera Exposure” 

Enabled.

� Use “Exposure for Non-Physical Cameras” to properly expose the Perspective and 

Orthographic views. This value is based on an EV Scale.

Physical Camera (3ds Max 2016-2017)
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� These settings will apply tone-mapping adjustments to the rendering, 
and can be found under the Physical Camera Exposure Control That 
will help with the contrast of the Highlights and the Shadows of the 
rendering. 

� Leave these settings at default. It will give really good results from the 

start.

� Set Highlights and Shadows to 0 to remove any tone-mapping.

� Leave Mid-tones set to 1.0.

� Doing this will allow Tone Mapping to be applied in Post Production.

� Save the output in 32-bit EXR for best Dynamic Range.

Physical Camera – Image Control
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� This setting will control Depth Of Field (DOF) in the camera. 

� Usually f/8.0 – f/11.0 is the sweet spot for most cameras, and is the 

ideal setting for shooting Architecture and Landscapes. This is due to 

how sharp the images come out, and results in very little DOF

� Decreasing the Aperture will increase the brightness, and increase
the DOF effect

� Increasing the Aperture will decrease the brightness, and decrease
the DOF effect

� Depth of Field needs to be enabled to take effect

Real-World Camera Settings – Aperture (f-stop)
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� This setting will control Motion Blur in the camera. The Shutter Speed 
will determine how fast the shutter of the camera closes. 

� The higher this setting, the faster the shutter will shut. This results in 

freezing objects in motion, and will also decrease the brightness of 

the image

� Lowering the Shutter Speed will allow objects in motion to become 

blurry, and will increase the brightness of the image.

� Motion Blur needs to be enabled to take effect.

Real-World Camera Settings – Shutter Speed 
(1/seconds)
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� This setting controls how much light hits the sensor in the camera. In 
the Real World, this would also control how much noise would be 
visible in the photograph. 

� Decreasing the ISO value will darken the image, but create less noise 
in the photograph. 

� Increasing the ISO value will brighten the image, but create more 
noise in the photograph. 

� Note: Since the renderings are completely digital, the ISO setting will 
not create any noise in the rendering. However, it is recommended to 

add some noise back in Post Production to help mimic the effect. This 

will help the renderings look more like a photograph when it is finished.

Real-World Camera Settings – ISO (Film Speed)
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� This is a value that combines the Exposure Triangle of Aperture (F-Stop), 
Shutter Speed, and ISO into one single value. All the various combinations 

will always yield the same level of exposure for the set Exposure Value. 

This can be a quick way to set the Exposure for the scene, especially if 

Depth of Field and Motion Blur are not required.

Real-World Camera Settings – Exposure Value 
(EV)

Daylight Settings
Full Sunlight EV 13-14
Hazy Sunlight EV 12
Cloudy Bright EV 12
Overcast EV 11
Open Shade with Clear Sunlight EV 11-12
Interior Lighting
Galleries EV 7-10
Office and Work Areas EV 6-8
Home Interiors EV 5-7
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� This value is based off of the Kelvin Temperature Scale, 
and will determine what color value will be considered 
white by the camera. For instance, if the temperature of 
a light is 5000k, and the White Balance is set to 5000k, 
the light will appear white in the rendering.

� The higher the number, which results in a cool 
temperature, the warmer the rendering will look. 

� The lower the number, which results in a warm 
temperature, the cooler the rendering will look. 

� A value of 6500K is perfect for exterior daytime 

renderings.

� A value of 4500-5000K is a good starting point for 

interior renderings.

Real-World Camera Settings – White Balance

Color 
Temperature

Light Source

6500K Daytime / Cloudy

5500K – 6500K Daytime

5000K Camera Flash or LED

4000K – 5000K Fluorescent Light

3000K – 4000K Sunrise / Sunset

25000 – 3000K Incandescent Lighting

2000 – 3000K Tungsten Bulbs
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Chapter 5: Iray Settings
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� Enable Iray in both Production and Active Shade
� Setting Rendering Calculations:

� Time – How long to render (Best to control time)

� Iterations – How many calculations (Best for consistent quality)

� Unlimited – Go until I say stop. (Best in Active Shade)

� Set Hardware Resources:

� Set the number of CPU Cores to render with

� Set which GPUs will do the rendering

� Disable GPU-0 (Windows) in ActiveShade for better performance

Render Settings Overview
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� Enable all CPUs and GPUs.
� LPEs are only available during 

Production Rendering.
� Best for rendering animations.
� Optimal Iterations for quality:

� Exterior: 3,000 – 5,000 

Iterations

� Interior: 10,000 – 15,000+ 

Iterations

Iray Production Mode
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� Interactive Features:

� Material Changes

� Camera/Perspective Changes

� Exposure Changes

� White Balance Changes

� Non-interactive Features:

� Creating Lights

� Changing Light Intensity

� Moving Lights*

Iray Active Shade
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Chapter 6: Irradiance Mode (2016 & 2017)
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� Enable Irradiance under the Render Elements

� This is found only in the Production Rendering Mode for Iray

� The main rendering will be completely white. The Irradiance will show 

up after the rendering fully completes.

� For best accuracy use the following

� IES files that are the correct specification to the lighting fixtures in the 

project.

� Use the 3ds Max Daylight System for the mrSun and mrSky.

� The following will reduce the accuracy of the Irradiance Render:

� Photometric Lights without IES files

� IBL (HDRI) used for the environment light and sunlight.

Irradiance Mode (3ds Max 2016-2017)
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Chapter 7: LPE and Post Production
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� Mathematical Equations that can pull specific elements out of 
the buffer for compositing in post

� Known as A Regular Expression Language (REGEX)

� Can write your own LPEs

� Visit NVIDIA’s blog for ongoing discussions

� blog.irayrender.com

LPE (Light Path Expressions)
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� Beauty Pass = L .* E

LPE Example: Beauty Pass
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� Area Lights = La .* E

LPE Example: Area Lights
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� Indirect Illumination = L {2,} E

LPE Example: Indirect Illumination (2+ Bounces)
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LPE Example: Adding Passes Together

+ =
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� Z-Depth and a few others

LPE Example: Standard Preset Render Element
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The Elements of LPEs

� Eye Event

� E – Eye/Camera/View
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The Elements of LPEs

� Eye Event

� E – Eye/Camera/View

� Light Event

� L – All Lights

� Lp – Point Lights

� La – Area Lights

� Le – Environment/Background Lights

� <L ‘handle’> - Light Source Defined by a Handle

� Set by Layer Name
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The Elements of LPEs

� Light Interaction Events: < t m h >

� Type (t)

� R – Reflection

� T – Transmission

� V – Volume
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The Elements of LPEs

� Light Interaction Events: < t m h >

� Type (t)

� R – Reflection

� T – Transmission

� V – Volume

� Mode (m)

� D – Diffuse

� G – Glossy

� S – Specular
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The Elements of LPEs

� Light Interaction Events: < t m h >

� Type (t)

� R – Reflection

� T – Transmission

� V – Volume

� Mode (m)

� D – Diffuse

� G – Glossy

� S – Specular

� Handle (h)

� Set by Layer Name
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The Elements of LPEs

� Symbols

� .  

� Defined as a ‘Wild Card’

� * 

� Defines any number of Set Light Source Events

� < > 

� Defines a Light Interaction Event

� [ ] 

� Defines a “Set” within a Light Interaction Event

� ^  

� Excludes, or inverts, an element from a Light Interaction Event.
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The Elements of LPEs

� Operands Symbols

� Quanifiers

� ?

� *

� +

� { }

� Concatenation

� A – First Event or First LPE

� B – Second Event or Second LPE

� Alternatives

� | - Shows one or the other
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The Elements of LPEs
� List of Operands

� AB

� Set A first, then B

� A | B

� Sets A or B

� A?

� Might set A, if A is present

� A*

� Sets any occurrences of A in sequential order, including zero
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The Elements of LPEs
� List of Operands

� A{n}

� Sets exactly n consecutive occurrences of A

� A{n,m}

� Sets from n to m, inclusively, occurrences of A

� A{n,}

� Sets n or more occurrences of A

� NAME: expression

� Sets a name for the expression for reference in another expression

� $name

� References another named expression

� ^expression

� Creates and inverse of the expression
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Deconstructing LPE’s
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Deconstructing LPE’s
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L.* <R[GS]> E

Deconstructing LPE’s

“Reflection” Pass LPE
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L.* <R[GS]> E

Deconstructing LPE’s

Light Event
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L.* <R[GS]> E

Deconstructing LPE’s

Light Interaction Event
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L.* <R[GS]> E

Deconstructing LPE’s

Eye Event
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’chairs’

Deconstructing LPE’s

This is a handle for the ‘chair’ objects 
in the render.
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L.* ’chairs’ E

Deconstructing LPE’s

All Direct Events on the “chairs” 
objects
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Deconstructing LPE’s
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L.* ’chairs’ .*E

Deconstructing LPE’s

All Events everywhere that effect 
“chairs” objects
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Deconstructing LPE’s
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L.* <RD’chairs’ .*E

Deconstructing LPE’s

All Reflective Diffuse Rays everywhere that 
effect “chairs” objects
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Deconstructing LPE’s
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L.* <RG’chairs’ .*E

Deconstructing LPE’s

All Reflective Glossy Rays everywhere that 
effect “chairs” objects
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Deconstructing LPE’s
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Let’s study some color 
options!
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� L .* ‘fwp’ .*E

LPE in Post Production – Fabric Wrapped 
Panels



© 2016 Autodesk© 2016 Autodesk

� L .* <RD’chairs’> .*E

LPE in Post Production – Chairs: Diffuse Pass
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� L.* <RG’chairs’> .*E

LPE in Post Production – Chairs: Glossy Pass
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� ^(L.* (‘fwp’ | ‘chairs’) .*E)

LPE in Post Production – Fabric Wrapped 
Panels
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LPE in Post Production – Photoshop Set Up

Beauty Pass = L .* E
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Chapter 8: Iray for 3ds Max
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� Convert Iray from 3ds Max to Iray for 3ds Max with a few clicks through an included 
converting tool.

� Iray for 3ds Max does not support Shaders other than the Iray for 3ds Max Shaders, so scenes 

will need to be converted.

� Iray for 3ds Max does not fully support the 3ds Max 2016 Physical Camera at this time.

� Direct MDL Support

� Import MDL through the Iray for 3ds Max Shader

� Supports “Measured Material” MDLs

� Fully Interactive in Active Shade

� Every change in the scene will be updated in Active Shade buffer

� Two Flavors

� Iray for 3ds Max

� Used for Photorealism

� Iray for 3ds Max Interactive

� Super-fast, but limits ray bouncing to achieve the speed.

� NVIDIA VCA Support
� Iray Server

Iray for 3ds Max Features
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NVIDIA Iray VCA

The NVIDIA VCA is a server contains 8 Quadro 
M6000s and can be linked together with other VCAs 
through InfiniBand technology. Iray for 3ds Max will 
allow a direct connection to the VCA, enabling 
users to have access more GPUs than their 
desktops could ever hold. When the VCAs are 
linked, the number of GPUs that are available to 
render with go up exponentially.

� 8 Quadro M6000s per VCA

� Linked VCAs through InfiniBand

� Direct Connection to VCA through Iray for 

3ds Max Interface

� Can reduce rendering times drastically

Images provided by NVIDIA
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� Supports any version of NVIDA Iray Plugins

� Can run on either Windows or Linux machines

� Cache Management minimizes submission times

� Flexible queue management system

� Entire cluster can coordinate together for rapid image creation

� Custom scripting allowed when jobs are completed

� Streaming behaves identically to local interactive rendering

Iray Server

Images provided by NVIDIA
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Chapter 9: Other Render Engines
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Key Things to Change

� Materials
� Depending on the engine you are using, Materials will need to be converted from the Autodesk Materials to the ones 

supported by your rendering engine of choice.

� Lights
� Some engines support the Photometric and Standard 3ds Max Lights, but some require users to use lights specific to the 

engine. This will require users to replace all lights in the scene with lights that are supported by the Engine

� Cameras
� The new Phsyical Camera inside of 3ds Max isn’t widely supported by most engines yet. Some engines will still support the 

Standard Camera, but others will require users to use Cameras that are specific to that engine.
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Scene Converter – 3ds Max 2017+

� Designed to help convert scenes from one 
rendering engine to another.

� Only supports converting scenes from 
Revit to Autodesk Raytracer (ART) out of 
the box.

� Requires support from 3rd Parties, or the 
community, to create the conversion scripts to 
run with the tool.

� Will help create back-ups and other 
workflows to ensure if a scene breaks, it 
can be fixed.
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Physical Material

� Designed to be a single material that can 
work across multiple engines. Support is 
open for 3rd parties to adopt. 

� Uses the Metallic/Roughness workflow that 
can be currently found in Unity or Unreal. 
But it also supports typical 
Reflectivity/Glossiness Workflows for 
backwards compatibility with “old” 
materials.

� Recommended to use this Material when 
using Autodesk Raytracer (ART)

� Not much 3rd Party support yet, but 
expected to grow in the upcoming releases. 
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Max Scripts can help!



© 2016 Autodesk© 2016 Autodesk

� Your class feedback is critical. Fill out a class survey now.

� Use the AU mobile app or fill out a class survey online. 

� Give feedback after each session. 

� AU speakers will get feedback 

in real-time.

� Your feedback results in better
classes and a better AU experience.

How did I do?



Autodesk is a registered trademark of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, and 

specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may appear in this document. © 2016 Autodesk, Inc. All rights reserved.

© 2016 Autodesk.  All rights reserved.


